
THE COLLABORATIVE LESSON 

 
The purpose of this assignment is for you to demonstrate your effect on student learning by collaborating with a classroom teacher to plan, teach, 

and assess a lesson that integrates information literacy skills with curricula content. 

  

In your last course, SLM 550 Professional Portfolio, you’ll be asked to select artifacts from previous courses and to write reflections.  Below are 

AASL Standards and elements that you might use in SLM 550 when reflecting on this activity.   

 

AASL/NCATE Standards and Elements Addressed: 

1.1 Knowledge of learners and learning 

Candidates are knowledgeable of learning styles, stages of human growth and 

development, and cultural influences on learning. Candidates assess learner needs 

and design instruction that reflects educational best practice. Candidates support 

the learning of all students and other members of the learning community, 

including those with diverse learning styles, physical and intellectual abilities and 

needs. Candidates base twenty-first century skills instruction on student interests 

and learning needs and link it to the assessment of student achievement. 

 

1.2 Effective and knowledgeable teacher 

Candidates implement the principles of effective teaching and learning that 

contribute to an active, inquiry-based approach to learning. Candidates make use 

of a variety of instructional strategies and assessment tools to design and develop 

digital-age learning experiences and assessments in partnership with classroom 

teachers and other educators. Candidates can document and communicate the 

impact of collaborative instruction on student achievement. 

 

1.3 Instructional partner 

Candidates model, share, and promote effective principles of teaching and 

learning as collaborative partners with other educators. Candidates acknowledge 

the importance of participating in curriculum development, of engaging in school 

improvement processes, and of offering professional development to other 

educators as it relates to library and information use. 

 

1.4 Integration of twenty-first century skills and learning standards 

Candidates advocate for twenty-first century literacy skills to support the learning 

needs of the school community. Candidates demonstrate how to collaborate with 

other teachers to plan and implement instruction of the AASL Standards for the 

21st-Century Learner and state student curriculum standards. 

 

Documentation Required 

 

1. Collaborative Planning Sheet 

2. Lesson Plan including student handouts 

3. Examples of student assessments and a written analysis of whether the completed assessments show the 

impact of the collaborative instruction on student learning. 

 

 

 

 

 

 

 



SCORING TOOL 

Student: 

Date Graded: 

Total Points  / out of 25 

 

Written Comments: 

 

 

 

Collaborative Lesson  

 
Criteria and 

Scoring 
Exemplary 

 

Proficient 

 

Developing 

 

Unsatisfactory 

 

Collaborative 

Planning 

Sheet 

3 pts. 

Outstanding plan that has been co-

planned, and co assessed by teacher and 

librarian. 

3 pts. 

 

Adequate plan that has been co-planned, 

and co assessed by teacher and librarian. 

2 pts. 

The learning experience relates to a 

content area but no joint planning, 

teaching or assessment was completed. 

1 pt. 

 

 

The learning experience was planned and 

taught in isolation. 

0 pts. 

 

 

 

 

Resources 

 

2 pts. 

Provides access to outstanding quality, 

quantity and variety of materials that 

include books, audiovisual, technology 

sources that support the lesson and 

provide for multiple literacies 

Resources met diverse needs and learning 

styles. 

2 pts. 

Provides access to suitable quality, 

quantity and variety of materials that 

include books, audiovisual, technology 

sources that support the lesson and 

provide for multiple literacies 

Resources met diverse needs and learning 

styles. 

1.5 pts. 

Provides access to adequate quality, 

quantity and variety of materials that 

include books, audiovisual, technology 

sources that support the lesson. 

Resources met a few diverse needs and 

learning styles. 

1 pts. 

 

 

Unattractive materials primarily print did 

not allow for diverse needs and learning 

styles. 

0 pts. 

 

Lesson 

Objectives 

 

2 pts. 

Clear and comprehensive objectives that 

closely match subject and library  

curriculum. 

Establishes clear criteria for successful 

application of information literacy  

skills and defines learning goals. 

2 pts. 

 

Objectives that match subject and library 

curriculum.  

1.5 pts. 

 

Library objectives are integrated into a 

content area assignment. 

1 pt. 

 

 

Library objectives only. 

0 pt 

 

 

 

Instructional 

Strategies 

4 pts. 

Uses results of diagnostic assessment to 

adapt instruction to student needs.  

Selects developmentally appropriate 

instructional techniques to meet varied 

learning styles. 

4 pts. 

Uses diagnostic assessment to adapt 

instruction to student needs. Appropriate 

instructional techniques to meet some 

different learning styles. 

2-3 pts. 

No use of diagnostic assessment results to 

adapt lesson. Limited instructional 

techniques to meet varied learning styles. 

1 pts. 

  

 

Little or no attempt to provide for 

different learning styles or diverse needs. 

0 pts. 

 

Lesson Plan 

4 pts. 

Outstanding, clear and well written; 

includes all components and allows for 

differentiation . Shows knowledge of 

student interest and motivation in 

instructional design.4 pts. 

Clear; includes all components.  

Shows some knowledge of student 

interest and motivation in instructional 

design. 

2-3 pts. 

Adequate lesson plan with 1-2 omissions. 

Shows little  knowledge of student interest 

and motivation  

1 pts. 

 

Poorly written plan with more than two 

components missing; .no attempt  to allow 

for differentiation. 

0 pts. 

Student 

Handouts 

2 pts. 

 

Very visually appealing with no grammar 

or spelling mistakes. 2 pts. 

 

Visually appealing with no mistakes. 

1.5 pt. 

 

Somewhat attractive with 2-5 mistakes. 

1 pt. 

 

Plain with unclear directions and 5 or 

more mistakes. .5 pts. 

Exemplary:  25 – 23 pts 
Proficient:    22 – 20 pts 
Developing: 19 – 17 pts 
Unsatisfactory: Less than 16 pts 
 



 

Delivery of 

Instruction 

4 pts. 

Implements current motivating teaching 

strategies that  develop the objectives; 

Provides meaningful interactive activities 

to accommodate diverse needs; student 

centered 

4 pts. 

Implements some current motivating 

teaching strategies that  develop the 

objectives; Provides  some meaningful 

interactive activities to accommodate 

diverse needs 

3 pts. 

 

Traditional teaching strategies ; Provides  

few meaningful interactive activities to 

accommodate diverse needs; teacher 

directed 

2 pts. 

 

Traditional teaching strategies; teacher 

directed 

1 pt. 

 

Analysis of 

Student 

Assessment  

4 pts. 

Outstanding use  of diagnostic, formative 

and summative assessments to evaluate 

impact on student learning and 

effectiveness of instruction 

Emphasis on student self-assessment and 

authentic assessment. 

4 pts. 

Adequate use of diagnostic, formative and 

summative assessments to evaluate impact 

on student t learning and effectiveness of 

instruction. Assessment more teacher 

directed. 

2-3 pts. 

 
Limited use of diagnostic, formative and 

summative assessments to evaluate impact 

on student learning. All teacher directed. 

1 pt. 

 

 

Little or no use of assessments to evaluate 

impact on student learning.  

0 pts. 



 

School Library Media Center Collaboration Planning 

 

Teacher(s): Beth Demers                                                                       Unit: Travel to Francophone Countries 

 

Grade Level: 9-12 French 2                Plan Date: 9/25/12 for 11/12-11/14 4A         Time Frame: 2x 1.5 hr classes 

 

Unit Overview and description: Students will research different French speaking countries from the prospective 

of a future tourist.   

 

 

Culminating Learning Product: Students will use the information that they generate to create an infographic 

advertisement for their assigned countries tourist board. 
 

AASL Standard(s): 

 AASL  21st Century Standards 
- 1.1.5 Evaluate information found in selected sources on the basis 
of accuracy, validity, appropriateness for needs, importance, and 
social and cultural context.   
-1.2.2 Demonstrate confidence and self- direction by making 
independent choices in the selection of resources and information. 
2.1.6 Use the writing process, media and visual literacy, and 
technology skills to create products that express new 
understandings. 
- 3.2.3 Demonstrate teamwork by working productively with others. 
- 3.4.3 Assess own ability to work with others in a group setting by 
evaluating varied roles, leadership, and demonstrations of respect 
for other viewpoints. 

 Technology Standards (NETS.S) 
-1. Students demonstrate creative thinking, construct knowledge, 
and develop innovative products and processes using technology. 
-3. Student apply digital tools to gather, evaluate, and use 
information. 
-4. Students use critical thinking skills to plan and conduct research, 
manage projects and make informed decisions using appropriate 
digital tools and resources.  
-5. Students understand human, cultural, and societal issues related 
to technology and practice legal and ethical behavior. 

Content Standards: 

Content Standards- Identify and observe 

products of Francophone cultures, such as 
food, clothing, athletics, leisure-time activities, 
and historical monuments. 
 

Local/State Standards and Indicators: 
-2A.2 Use safe practices when online. Identify 
and follow the district’s Acceptable Use Policy 
and school-based computer use rules. Apply 
safe practices for both assignment-related and 
personal online searches. 
-2B.1 Independently and ethically located 
sources to meet the information need. 
-3C.1.Collaboratively and independently 
record data/information in a variety of 
formats. 
-5A.1 Individually and collaboratively use a 
variety of formats to prepare the 
findings/conclusions of the information need 
for sharing. 

 

Project Description (including goals and objectives): 
Students will create a Digital poster advertisement for a Francophone   

 Tabloid Size 11x17 

 The Official Name of the Country 

 A Catchy title in French and English 

 Visual representation of the national flag 

 Visual representation of the country shape 

 A graphic for each type of information provided 

 A list of citations for your information and images. 

Essential Questions: 

 

 What information does a student need 
to plan a successful trip abroad? 

 How can we assist students to find 
accurate and reliable information? 

 How do we teach kids to be digitally 
responsible creators? 



Teacher will:  

 Divide students into groups 

 Assign research country 

 Grade Content portion of final project 

 Facilitate students during work time 

Library Media Specialist will: 

 Create information collection handout 

 Create class prezi 

 Grade citation portion of final project 

 Introduce project 

 Prepare Warm-ups 

Materials: 

Resources: 

_Internet     _Publisher     _Databases (CultureGrams) 

Unit Assessments: 

Diagnostic- Warm-up and Discussion 

Formative- Digital Poster Product 

Summative- Graphic organizer, participation, class 

discussion, one-to-one check in. 

 

Project Calendar 
 Daily Learning Activities 

 T-Teacher and MS-Media Specialist 

Day 1 T-Take attendance and bring students down to the media center 
MS- Lead warm-up and introduce project 
T/MS- Supervise class on computers 

Day 2 T--Take attendance and bring students down to the media center 
MS-Facilitate warm-up discussion 
MS-Introduce Publisher Activity 
MS/T-Supervise computer use. 

 

 

 

 

 

 

 

Teacher/Media Specialist Evaluation of Unit: Overall, this was a very successful lesson plan.  In the future, 

it would be good to do a mini-lesson on publisher.  We would also like to take time to do a peer review 

focusing in on the features of the infographic.  We noticed that many students struggled with print v. graphics.  

We could design it as a commercial feedback session and have the students give each other feedback.    



School Library Media Lesson Plan 

Title of Lesson: Travel to Francophone Countries 

Overview of Lesson: Students will research pertinent information 

about different French speaking countries.  They will then use the 

information gathered to create an infographic poster advertisement 

designed to entice travelers to their destination. 

Resources Needed:  

 Computers w/ 

 Access to the internet 

 Access to CultureGrams 

database 

 Microsoft Publisher 

 Prezi 

 Handouts 

 Warm-Up/Exit Slips x2 

 Country Information 

worksheet 

 Publisher Cheat Sheet 

 Infographic Checklist w/ 

Rubric and Daily 

participation grade 

 Infographic Warm-up 

Essential Question(s): 

 What information does a student need to plan a successful 
trip abroad? 

 How can we assist students to find accurate and reliable 
information? 

 How do we teach kids to be digitally responsible creators? 

Integrated Standards and Indicators 

 AASL  21st Century Standards 
- 1.1.5 Evaluate information found in selected sources on the basis of 
accuracy, validity, appropriateness for needs, importance, and social 
and cultural context.   
-1.2.2 Demonstrate confidence and self- direction by making 
independent choices in the selection of resources and information. 
-2.1.6 Use the writing process, media and visual literacy, and 
technology skills to create products that express new understandings. 
- 3.2.3 Demonstrate teamwork by working productively with others. 
- 3.4.3 Assess own ability to work with others in a group setting by 
evaluating varied roles, leadership, and demonstrations of respect for 
other viewpoints. 

 Local/State Standards and Indicators 
-2A.2 Use safe practices when online. Identify and follow the district’s 
Acceptable Use Policy and school-based computer use rules. Apply safe 
practices for both assignment-related and personal online searches. 
-2B.1 Independently and ethically located sources to meet the 
information need. 
-3C.1.Collaboratively and independently record data/information in a 
variety of formats. 
-5A.1 Individually and collaboratively use a variety of formats to 
prepare the findings/conclusions of the information need for sharing. 

 Content Standards 
- Identify and observe products of Francophone cultures, such as food, 

clothing, athletics, leisure-time activities, and historical monuments. 
 Technology Standards (NETS.S) 

-1. Students demonstrate creative thinking, construct knowledge, and 
develop innovative products and processes using technology. 
-3. Student apply digital tools to gather, evaluate, and use information. 
-4. Students use critical thinking skills to plan and conduct research, 
manage projects and make informed decisions using appropriate digital 
tools and resources.  
-5. Students understand human, cultural, and societal issues related to 
technology and practice legal and ethical behavior. 

Desired Outcomes:  
 Students will gain a better understanding of Francophone countries and what 

they have to offer to tourists. 

 Students will use reliable sources to find accurate information about 
Francophone countries. 

 Students will use MLA documentation standards to show digital responsibility.  

Estimated Time: 3 hours 



 
Teaching Strategies 

___ Scaffolded Questioning 

__x_ Independent Reading 

___ Interpretation of Primary  

        Sources 

__x_ Interpretation of Graphics  

       (maps, graphs, cartoons,  

       tables,…) 

___ Concept Attainment 

__x_ 150 Words or less 

___ Grouping Strategies 

___ Think-Pair-Share 

___ Roundtable 

___ Jigsaw 

___ Pairs Check/Review 

_x__ Indep/Group Project 

__x_ Integration of Technology 

___ Audio 

_x__ Formal Writing 

_x__ Informal Writing  

___ Modeling/Demonstration 

___Small/Large Group 

___ Reading (Pre, During, Post) 

___ Simulation/Act-it-Out   

___ Video Clips 

___ Cross-Curricular Connections 

___ Other_________________ 

 

Instructional Plan 

DAY 1  
Engagement/Motivation:  

Warm-up will be waiting on the tables when students 

enter into the classroom.  “Day 1: What information do 

you look for when determining a vacation location?  

What do people research before they travel?” Students 

will be given a few minutes to brainstorm what they 

would look for.  

AASL 
3.4.3 

Differentiation/Strategies 
___ Tiered assignments 
_x__ Flexible grouping 
___ Learning centers 
___ Curriculum compacting 
___ Varying questions 
_x__ Independent Projects 

Multiple Intelligences 
V=Verbal/Linguistic 
M=Musical/Rhythmic 
L=Logical/Mathematical 
S=Visual/Spatial 
B=Body/Kinesthetic 
IA=Intrapersonal 
IR=Interpersonal 

Modifications 
___ Adapting the skill level 

___ Adapt  number of items 

___ Adapt materials 
___ Provide learning strategy   

___ Provide audio/video/digital 

       access 

___ Increase personal assistance 
IEP Goals/Accommodations 

 

Pre-Assessment of Prior Knowledge:  

After students have had a chance to brainstorm their 

ideas classroom teacher and MS will lead a discussion 

about what they already know.  Some students will 

have a lot of knowledge about traveling while others 

have never left MD.  

3.4.3 

Direct Instruction:  

CT will talk about the importance of research before 

travel begins.  She will explain how countries develop 

advertisements to lure people into their country.  MS 

will use the class Prezi to introduce the assignment and 

explain the databases.  CT will hand out the “Country 

Information Handout” while MS is walking students 

through the assignment.  

1.1.5 

Modeling/Guided Practice:  

MS will explain the location of the “Culture Grams” 

database as well as other places to look for 

information.  

1.1.5 

Independent Practice: Students will work in pairs to 

find the information they are looking for.  Teacher and 

MS will circulation to answer questions and keep 

students on task. 

1.2.2 

3.2.3 

3.4.3 

Assessment 

o Product: Country Information Handout 
o Process: Citation Notes 
o Student Self-Questioning: Exit slip 

allowing students to self assess their 
day and ask any questions. 

2.1.6 

 



DAY 2 

Engagement/Motivation: Each student table will have 

an infographic on it with these three questions: 

 How does the author use images to make 

his/her point? 

 How does the author use color to make his/her 

point? 

 What are the pro’s and con’s of presenting 

information in this format? 

MS will lead a discussion about the class findings. 

3.4.3 

Pre-Assessment of Prior Knowledge: MS will ask how 

many students have never used Microsoft Publisher 

before.  Those that raise their hand will be directed to 

the Publisher Cheat Sheet to get them started.  

3.4.3 

Direct Instruction: MS will go over the requirements 

for the infographic.  Each group will be given a 

checklist for their project.  

3.4.3 

Independent Practice: 

Each student group will work on their infographic  

3.4.3 

Assessment 

o Product: Infographic 
o Process: Rubric Page 

Student Self-Questioning:  

What is your favorite aspect of your project? 

What would you improve if you had more time? 

 

After Lesson Reflection: It was difficult working with a group of 

students that I do not know.  I had to rely on the management style 

of the classroom teacher.  When I realized that the teacher did not 

have a whole lot of structure I created the checklist assignment to 

help keep individual students on task.  I thought the students did a 

great job at finding the research. I am glad that we structured the 

finding of information.  I think the kids would have been lost 

without the structured form to fill out.  On the second day I noticed 

that the students made a lot of comments on the warm-up sheets 

that were not reflected in the class conversation.  The major things I 

would add to the process is a self or peer review.  The final 

products needed some fine tuning.  

 

 

 

 

 

 

 

 

 

 



Country Name:  
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Capital: 
 
 

How far away from US: 

Population: 
 
 

Type of Government: 

Currency: 
 
 

Major Religions: 

Adult Literacy Rate: 
 
 

Transportation Options: 

Best Time to Visit the Country and reason: 
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Major Tourist Cities: 
 
 
 
 
 
 

Major Holidays and Celebrations: 
 
 
 
 
 
 

Cultural Attractions: 
 
 
 
 
 

Historical Attractions: 
 
 
 
 
 

Natural Attractions: 
 
 
 
 
 
 



Citation Information 
Use this page to record the citation information for all source of your information.  Make sure that you cite the 

source of any image that you intend to use on your infographic. If you need help forming your citation use 
noodletools.com to create your citation. 

1 ____________________________________________________________________________________________________

_________________________________________________________________________________________________

_________________________________________________________________________________________________

______________________________________________________________________________________________ 

 

2 ____________________________________________________________________________________________________

_________________________________________________________________________________________________

_________________________________________________________________________________________________

______________________________________________________________________________________________ 

 

 

3 ____________________________________________________________________________________________________

_________________________________________________________________________________________________

_________________________________________________________________________________________________

______________________________________________________________________________________________ 

 

4 ____________________________________________________________________________________________________

_________________________________________________________________________________________________

_________________________________________________________________________________________________

______________________________________________________________________________________________ 

 

 

5 ____________________________________________________________________________________________________

_________________________________________________________________________________________________

_________________________________________________________________________________________________

______________________________________________________________________________________________ 

 

6 ____________________________________________________________________________________________________

_________________________________________________________________________________________________

_________________________________________________________________________________________________

______________________________________________________________________________________________ 

 

 

7 ____________________________________________________________________________________________________

_________________________________________________________________________________________________

_________________________________________________________________________________________________

______________________________________________________________________________________________ 



Using Microsoft Publisher 

Create a new publication 

1. Click the File tab, and then click New. 

2. Under Available Templates, click a 

blank publication template, and then 

click Create. 

 Note: If you do not see a blank template that is 

the size you want, click More Blank Page 

Sizes. 

Save a publication 

By default, Publisher saves a file in a default 

working folder. If you want, you can specify a 

different location. 

 Click the File tab, and then click Save. 

 Notes: If you are saving a file for the first time, 

do the following: 

1. In the Save As dialog box, in the File 

name box type a name for your 

publication. 

2. Click Save. 

Insert a text box 

1. On the Insert tab, click Draw Text Box 

. 

2. In your publication, point to where you 

want one corner of the text box to 

appear, and then drag diagonally until 

you have the text box size you want. 

3. Click inside the text box and type your 

text. 

Insert and crop images 

Insert a picture 

1. On the Insert tab, in the Illustrations 

group, click Picture. 

2. In the left pane of the Insert Picture 

dialog box, click the folder that contains 

the picture that you want. 

3. In the right pane of the Insert Picture 

dialog box, open the folder that contains 

the picture that you want. 

4. Click the picture and then click Insert. 

Crop a picture 

1. Select the picture that you want to crop. 

2. Under Picture Tools, on the Format 

tab, in the Crop group, click Crop. 

 Note: If you do not see the Picture Tools or 

Format tabs, make sure that you have selected 

the picture. You might have to double-click the 

picture to get the Format tab to appear. 

3. Position the cropping handle over an 

edge or corner. 

4. Do one of the following: 

 To crop one side, drag the center handle 

on that side. 

 To crop evenly on two sides at once, 

hold down CTRL as you drag a center 

handle. 

 To crop all four sides simultaneously 

and maintain the proportions of your 

picture, hold down CTRL+SHIFT while 

you drag a corner handle. 

Save your publication in PDF format 

Choose this option if you want to save your 

publication in a format that can be easily shared 

and is used by many commercial printers.  

1. In Publisher, open the publication that 

you want others to view. 

2. On the File menu, click Publish as PDF 

or XPS. 

3. In the Save as type list, select PDF. 

Your publication will be saved by default as 

publication name.pdf, and it will be optimized 

for high-quality printing. 

4. Click Publish. 

 Note   You can also save the file as a .pdf file 

by using the Save As dialog box.



Creating an Awesome Infographic 

When creating an infographic you want to focus on two key features. 

1. The Visual  
o Color Choice:  

1. Choose your colors wisely.  Think about what the colors are telling the reader. 
2. Stay consistent.  Keep your font and color coding consistent.  (For example: do all of your 

headings in blue and further reading in green.) 
o Graphics 

1. Choose graphics that are simple and easy to identify. 
2. Make sure that your graphic files are smaller…the larger the graphic, the more time it takes to 

load onto the computer.  
3. Make sure that you cite your sources. 

o Reference Icons 
1. Use universal symbols to indicate basic information.  
2. Group information together and give cues to your reader using text features.  
3. People should be able to find information easily. 

2. Content  
o Facts 

1. Make sure that the information you are giving is accurate and reliable. 
2. Make sure that all information leads back to the project’s intent.  

o References 
1. Use MLA citation to accurately cite your sources.  This will allow your reader to fact check. 
2. List one or two URLs that the reader could go to find more information. 

MLA Citation Style Cheat Sheet  

Edited from “MLA Works Cited: Electronic Sources.” OWL Purdue Staff. Purdue Owl. Web. 12 Nov. 2012. 

Citing an Entire Web Site 
 Editor, author, or compiler name (if available). Name of Site. Version number. Name of institution/organization affiliated 

with the site (sponsor or publisher), date of resource creation (if available). Medium of publication. Date of access. 
Remember to use n.p. if no publisher name is available and n.d. if no publishing date is given. 
 Example: Felluga, Dino. Guide to Literary and Critical Theory. Purdue U, 28 Nov. 2003. Web. 10 May 2006. 

 
A Page on a Web Site 
"How to Make Vegetarian Chili." eHow. Demand Media, Inc., n.d. Web. 24 Feb. 2009. 
 
An Image (Including a Painting, Sculpture, or Photograph) 

 Provide the artist's name, the work of art italicized, the date of creation, the institution and city where the work 
is housed. Follow this initial entry with the name of the Website in italics, the medium of publication, and the 
date of access. 

 Goya, Francisco. The Family of Charles IV. 1800. Museo Nacional del Prado, Madrid. Museo National del Prado. Web. 22 
May 2006. 

 If the work is cited on the web only, then provide the name of the artist, the title of the work, the medium of the work, and 
then follow the citation format for a website. If the work is posted via a username, use that username for the author. 

 brandychloe. "Great Horned Owl Family." Photograph. Webshots. American Greetings, 22 May 2006. Web. 5 Nov. 2009. 
 
CultureGram Citation 
"Name of Country." CultureGrams Online Edition. ProQuest, 2012. Web. 12 Nov 2012. 



Day 1 Warm-Up: What information do you look for when determining a vacation location?  What do people 

research before they travel? 

 

 

 

 

 

 

 

 

 

Exit Slip: 

What did you accomplish today? 

 

 

 

 

 

 

What questions do you have about the assignment? 

 

 

 

 

 

 

 

 

Day 1 Warm-Up: What information do you look for when determining a vacation location?  What do people 

research before they travel? 

 

 

 

 

 

 

 

Exit Slip: 

What did you accomplish today? 

 

 

 

 

 

 

What questions do you have about the assignment? 



Day Two: Creating an Infographic 

Your Task: Use Microsoft Publisher to create an infographic that will be visually appealing on and off the computer.   

Your infographic should include: 
 Tabloid Size 11x17 

 The Official Name of the Country 

 A Catchy title in French and English 

 Visual representation of the national flag 

 Visual representation of the country shape 

When you are finished please save your work as a .PDF and turn your infographic in to the hand-in folder on the campus drive. 
 

  

 4 3 2 1 

Ideas  The product communicates 
clearly relevant information 
listed in the criteria chart 
appropriately and effectively. 

 The information listed in the 
criteria chart is given in a lot of 
detail. 

  Information is in own words. 

 The product communicates 
relevant information listed in the 
criteria chart appropriately. 

 The information listed in the 
criteria chart is given in some 
detail. 

 Most information is in own 
words. 

 The product has some relevant 
information listed in the criteria 
chart. 

 Some of the information listed in 
the criteria chart is missing and/or 
given in little detail. 

  Some information is copied. 

 The product has little to no 
relevant information listed in 
the criteria chart. 

 Information listed in the 
criteria cart is missing and 
there is no detail.  

  Most of the information is 
copied. 

Organization  The product has excellent 
formatting and very well 
organized information.  It follows 
the format/structure. 

 The product has appropriate 
formatting and well- organized 
information.  It closely follows the 
format/structure. 

 The product has some organized 
information with random 
formatting. 

 The product’s format and 
organization of the material 
are confusing to the reader. 

Conventions  All the writing is done in 
complete sentences. 

 Capitalization and punctuation 
are correct throughout. 

 Most of the writing is done in 
complete sentences. 

 Most of the capitalization and 
punctuation are correct.  

 Some of the writing is done in 
complete sentences. 

 Some of the capitalization and 
punctuation are correct.  

 Most of the writing is not 
done in complete sentences. 

 Most of the capitalization and 
punctuation are not correct. 

Graphics  Graphics are included throughout 
the brochure.   

 The graphics go well with the 
text, and there is a good mix of 
text and graphics. 

 Some graphics are included 
throughout the brochure. 

 The graphics go well with most of 
the text. 

 Few graphics are included 
throughout the brochure. 

 Some of the graphics do not go 
well with the text. 

 Little to no graphics are 
included. 

 The graphics do not go with 
the accompanying text or 
appear to be randomly 
chosen. 

Citations  All information and graphics are 
cited in MLA format. 

 Most information and graphics 
are cited in MLA format. 

 Information is cited but not in 
MLA format. 

 Information is not cited or 
citations are incompete. 

 The information you found on your graphic organizer. 
 A graphic for each type of information provided 

 A list of citations for your information and images. 

 



Student Name:  

 

Rate the following categories with a 

score 1-5:  

1=not at all    5 = absolutely. 

Student Response 1-5 

Explain why. 

Teacher 1-5 

Focus:  I stayed focused in 

class and was not distracting 

other students. 

  

Volume: I was considerate of 

my classmates and kept my 

volume to a low murmur. 

  

Productivity: I got a lot done 

towards my research paper and 

used my time wisely. 

  

1. What is your favorite aspect of your project? 

 

 

 

 

 

 

 

2. What would you improve if you had more time? 

 

 

 

 

 

 

 

 

3. What role did you play in the creation of this project? 
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 -  

How does the author use 

images to make his/her point? 

 

 

 

 

 

 

 

How does the author use color 

to make his/her point? 

 

 

 

 

 

 

 

 

What are the pro’s and con’s of 

presenting information in this 

format? 
 



   

How does the author use 

images to make his/her point? 

 

 

 

 

 

 

 

How does the author use color 

to make his/her point? 

 

 

 

 

 

 

 

 

What are the pro’s and con’s of 

presenting information in this 

format? 
 



   

Analysis of Lesson 

Examples of student assessments and a written analysis of whether the completed 

assessments show the impact of the collaborative instruction on student learning. 

 

This collaborative effort showed a merging of skill sets and embodied true collaboration.  

When the teacher and I first met, she had a general idea of what she wanted but she was 

not sure how to accomplish it.  From our initial discussion we decided that we wanted to 

use some form of technology.  I suggested Microsoft Publisher because it had a lot of 

practical uses that students could apply to other classes and projects.  

 

We also realized that we wanted the students to explore unknown countries.  Ms. Demers 

provided a list of the countries and her intention was to use Google to find information.  I 

brought to her attention some of the databases that the school had that would be ideal for 

the sorts of information her students were looking for.  We settled on using 

CultureGrams, Gale Encyclopedia and, as a last resort, Google if needed. I developed a 

worksheet that would help the students keep track of their information and track their 

sources.  This was integral to their success.  As we were observing the students we 

noticed that they needed constant reminder to cite their sources.  As a result of this 

observation I created a citation quick guide and list for day two.  It was interesting to 

debrief after the first day because the things that I noticed were very different from those 

that the teacher noticed because of our backgrounds.  She was focused on the content and 

I was more concerned about the way they went about finding the information. 

  

When we look at the final products that were created on day two I think that it is a good 

example of collaborative effort.  The students got very creative with their product and the 

classroom teacher felt that her overall curricular goal was accomplished.  In retrospect, 

we both agree that there needed to be an element of review before turning in the final 

product which we noted on our notes and would change the next time we did this project.



   

 


